
 

 

 
 

Test Bench for IRS 
 
Overview: 

The new high end IRS systems available since January 2010 are equipped with a Datalog module that 
can be used to record all the events occurring in the IRS and power supply. 
This function allows for much better maintenance of IRS systems. 
This document describes the testing procedure to detect damages in IRS systems. 

 
Attention: 

 
When connecting a computer to IRS module through the serial link, you have to ensure that both 
devices are wired to the same ground to avoid any electrical discharge that can damage both 
devices.  

 

Safety :  
 

The installation, configuration, commissioning and maintenance of the IRS products must only be 
carried out by personnel qualified and trained to work with low voltage electrical equipment in an 
industrial environment.  

 
The front door should not be opened except by competent technicians when connecting or 
disconnecting  the device.  Electrical isolation must be ensured between the equipment and the 
power supply.  

 
 In both off and on modes, the IRS regulator doesn’t ensure isolation from the power 
supply. One should pay attention to the fact that electrical shock may occure when 
touching the lamps or the cables coming from the IRS.  It is thus recommended to turn off 
the power supply (400 V) within 2 sec following the end of regulation.  

 
1. Testing the ground circuit 

1.1 Testing the ground circuit between IRS door and IRS box  
1.1.1 Technical requirements 
To measure the resistance between IRS door and IRS box. The measured value must be in tenths of 
Ohms.  

1.1.2 Instruments and tools 
Multimeter. 

1.1.3 Procedure 
The IRS under examination must be disconnected from the power supply! 
Turn 24V power supply OFF. Set your Multimeter to resistance measuring mode and select the Ohms 
section. Open the IRS box door and place one mutimeter probe on it. Place the other probe on IRS 
box. Measure the resistance.  

1.1.4 Test report 
If the measured resistance value meets the requirements of clause 1.1.1, then the test - Passed (P), if 
not - Not Passed (N). 



 

 

1.2 Testing the ground circuit between the earth ground of 
MCU board and IRS box  

1.2.1 Technical requirements 
To measure the resistance between the earth ground of MCU board and IRS box. The measured value 
must be in tenths of Ohms.  

1.2.2 Instruments and tools 
Multimeter. 

1.2.3 Procedure 
The IRS under examination must be disconnected from the power 
supply! 
Turn 24V power supply OFF. 
Set your Multimeter to resistance measuring mode. Select the Ohms 
section. Open the IRS box door and place one multimeter probe at the 
control point TP2 of MCU board (as shown in Fig. ). Place the other 
probe on IRS box. Measure the resistance between these 2 points.   
1.2.4 Test report 
If the measured resistance value meets the requirements of clause 1.2.1, then the test - Passed (P), if 
not - Not Passed (N). 

1.3 Testing the ground circuit between PROFIBUS connector 
and IRS box 

1.3.1 Technical requirements 
To measure the resistance between the ground of Profibus and IRS box. The measured value must be 
in tenths of Ohms. 
1.3.2 Instruments and tools 
Multimeter. 

1.3.3 Procedure 
The IRS under examination must be disconnected from the power 
supply! Turn 24V power supply OFF. 
Set your Multimeter to resistance measuring mode. Select the Ohms 
section. Place one Multimeter probe at the Profibus connector (as shown 
in Fig.). Place the other probe on IRS box. Measure the resistance.  
1.3.4 Test report 
If the measured resistance value meets the requirements of clause 1.3.1, then the test - Passed (P), if 
not - Not Passed (N). 

1.4 Testing the ground circuit between the earth ground of 
Power board and IRS box  

1.4.1 Technical requirements 
To measure the resistance between the earth ground of MCU board and IRS box. The measured value 
must be in tenths of Ohms. 
1.4.2 Instruments and tools 
Multimeter 

1.4.3 Procedure 
The IRS under examination must be disconnected from the power 
supply! Turn 24V power supply OFF. 
Set your Multimeter to resistance measuring mode. Select the Ohms 
section. Open the IRS box door and disconnect CN6 from MCU board. 
Place one multimeter probe at pin2 of CN6 connector (as shown in 
Fig), place the other probe on IRS box. Measure the resistance. Then connect CN6 back to MCU 
board. 



 

 

1.4.3 Test report 
If the measured resistance value meets the requirements of clause 1.4.1, then the test Passed (P), if 
not - Not Passed (N). 
 

2. Testing the insulation 
2.1 Testing the insulation between IRS box and poles of the 
power connector (breakers in “close” position, 24V OFF) 

2.1.1 Technical requirements 
To measure the resistance of the insulation between IRS box and poles of the power connector. The 
measured value must be no less than 470 KOhms. 
2.1.2 Instruments and tools 
Multimeter 

2.1.3 Procedure 
The IRS under examination must be disconnected from the power 
supply! Turn 24V power supply OFF. Open the IRS box door and 
set both breakers to “close” position. Set your Multimeter to 
resistance measuring mode and select the measuring limit - 
MOhms. Place one multimiter probe on IRS box, place the other 
probe at one of the power connector poles (as shown in Fig). Wait 
for the reading on the Multimeter display to stabilize. Measure the 
resistance. Then change the polarity of the probes and measure 
the resistance again. Repeat the procedure for the other pole of 
the power connector. 
2.1.4 Test report 
If the measured resistance value meets the requirements of clause 2.1.1, then the test Passed (P), if 
not - Not Passed (N). 

 
2.2 Testing the insulation between IRS box and poles of the 
power connector (breakers “close”, 24V ON) 

2.2.1 Technical requirements 
To measure the resistance of the insulation between IRS box and poles of the power connector. The 
measured value must be no less than 470 KOhms. 
2.2.2 Instruments and tools 
Multimeter, 24V power supply unit. Tool T5. 

2.2.3 Procedure 
 The IRS under examination must be 
disconnected from the power supply! 
Connect 24V power supply to IRS with the 
cable Tool T5 (as shown in Fig).  
Attention! When 24V power supply unit is 
switched on for the first time, watch the 
absorbed current! It must not exceed 
300mA. 
 
 
 
 
 
  
 



 

 

Open the IRS box door and switch the both breakers to “close”. Set your Multimeter to resistance 
measuring mode and select the measuring limit - MOhms. Place one multimiter probe on IRS box, 
place the other probe at one of the power connector poles (as shown in Fig item 2.1.3). Wait for the 
reading on the Multimeter display to stabilize. Measure the resistance. Then change the polarity of the 
probes and measure the resistance again. Repeat the procedure for the other pole of the power 
connector. 

2.2.4 Test report 
If the measured resistance value meets the requirements of clause 2.2.1, then the test Passed (P), if 
not – the test Not Passed (N). 

2.3 Testing the resistance between the power connector 
poles (breakers “close”, 24V ON) 

2.3.1 Technical requirements 
To measure the resistance between IRS box and poles of the power connector. The measured value 
must be 570 Ohms +/-10%. 
2.3.2 Instruments and tools 
Multimeter, 24V power supply unit. Tool T5. 

2.3.3 Procedure 
 The IRS under examination must be 
disconnected from the power supply! 
Connect 24V power supply to IRS with the 
cable Tool T5 (as shown in Fig). 
 
 
 
 
 

Open the IRS box door and switch the both breakers “close”.  Set 
your Multimeter to resistance measuring mode and select the 
measuring limit - MOhms. Place one multimiter probe on IRS box, 
place the other probe at one of the power connector poles (as shown 
in Fig). Wait for the reading on the Multimeter display to stabilize. 

Measure the resistance. Then change the polarity of the probes and measure the resistance again.  

2.3.4  Test report 
If the measured resistance value meets the requirements of clause 2.3.1, then the test Passed (P), if 
not – Not Passed (N). 
 

3. Testing the communication 
3.1 Testing USB communication 

3.1.1 Technical requirements 
To check USB communication between IRS and personal computer (PC) 
3.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. 

3.1.3 Procedure 
Open the IRS box door. Connect USB cable to PC or NoteBook, 
connect the other end of the cable to MCU board. Switch PC or 
NoteBook ON. Start up SuperVisor. Select the COM port 
corresponding to the virtual USB COM port. Turn the 24V power 
supply ON. If the USB connection is kept OK, the green LED near the 
USB connector on the MCU board must be glowing permanently, and the 
indicating icon must appear in the bottom of SuperVisor window: 

3.1.4 Test report 

+24V 0V 



 

 

If the USB operates OK without failures, then the test Passed (P), if not - Not Passed (N). 
 

3.2 Setting the clock, checking the clock rate accuracy and 
backup supply 

3.2.1 Technical requirements 
To check if the clock is set up, to test the rate accuracy and backup supply. availability 
3.2.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. 

3.2.3 Procedure 
To set up the Real Time Clock (RTC) it is necessary to set up USB connection. Open the IRS box 
door. Connect USB cable to the PC or NoteBook, connect the other end of the cable to MCU board. 

Switch the PC or NoteBook ON. Start up SuperVisor. Select the COM 
port corresponding to the virtual USB COM port. If the USB connection 
is kept OK, the green LED near the USB connector on the MCU board 
must be glowing permanently. Next you 
need to select SetTime from the menu. At 
his moment your PC time will be set for the 
RTC Datalog, and the window with the 
current RTC value will open (see pic. 
below).  
Then press Set Time button. PC Time and MCU Time must get the 
same. Then turn the 24V power supply OFF for 10 minutes and turn it 
ON again.  PC Time and MCU Time must be the same.  

3.2.4 Test report 
If RTC has set up correctly, the rate is correct and the time reading remains correct after switching off 
the 24V power supply, then the test Passed (P),  if not – Not Passed (N). 
 

3.3 Testing PROFIBUS 
3.3.1 Technical requirements 
To test Profibus communication and Oven ON command operation. 

3.3.2 Instruments and tools 
24V power supply unit. PLC OMRON with Profibus module. Personal computer (PC) or NoteBook with 
installed SuperVisor and CXOne software. Tool T5. Tool T4. RS232 OMRON cable. USB cable. 

3.3.3 Procedure 
Connect PLC OMRON to MCU board of the tested IRS with cable Tool T4, connect PLC OMRON to 
PC or Notebook wit special RS232 cable (12) (supplied with OMRON). To make the connections follow 
the general testing scheme in clause 10.2.   Start up CX One 
Programmer on PC or Notebook. Then start up the testing program in 
Programmer.  
Watch that Profibus address is set correctly on MCU board. Turn 24V 
power supply ON. Start up the testing program in CX Programmer. 
Profibus LED on MCU board must be glowing permanently. It will 
indicate that the Profibus protocol connection is OK. For more detailed 
information about Profibus operation, read AN PROFIBUS AND 
AUTOMATION EXAMPLE WITH OMRON PLC CJ1M. 

3.3.4 Test report 
If Profibus communication operates OK without failures, then the test 
Passed (P), if not - Not Passed (N). 

4. Checking the Firmware versions 
4.1 Checking the Firmware versions 

A B 

 SHIELD 



 

 

4.1.1 Technical requirements 
To check compatibility of the Firmware and Hardware versions: 
 

 IRS-SDL IRS-STD 
Version Hardware v.101; Firmware v.20.17 Hardware v.20; Firmware v.50.18 

 10 channels 10 channels or 12 channels 
Power Source 400VAC+/-10%; 

 if 400VAC+/-20% - event 
208…530VAC 

if 400VAC +20% - event 
Regulation 0-100%  U^2 Power regulation 

Type of Regulation Single Cycle Single Cycle and Phase Angle 
 Fast identification of broken lamp Resistance measurement 

4.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. 

4.1.3 Procedure 
Open the IRS box door. Connect USB cable to PC or NoteBook, 
connect the other end of the cable to MCU board. Switch PC or 
NoteBook ON. Start up SuperVisor. Select the COM port 
corresponding to the virtual USB COM port. Turn the 24V power 
supply ON. If the USB connection is kept OK, the green LED 
near the USB connector on the MCU board must be glowing 
permanently. In the bottom of SuperVisor window see 
information about Firmware and Hardware versions. 
4.1.4 Test report 
Record Firmware and Hardware versions in the test report. 
 

5. Checking the configuration parameters 
5.1 Checking the configuration parameters 

5.1.1 Technical requirements 
Check the values of: 

a.Serial Number (ID) 
b.Number of hardware version  
c.Running Mode (Single Cycle or Phase Angle) 
d.Broken Lamp Factor 
e.Broken Lamp Tick 
f.Value of constant MMV (MainMaxVolts = 700…900V) 
g.Value of constant MMA (MainMaxAmps = 10…20A) 
i.Burst Firing Threshold  
k.Burst Firing Power 

5.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. 

5.1.3 Procedure 
Open the IRS box door. Connect USB cable to PC or NoteBook, connect the other 
end of the cable to MCU board. Switch PC or NoteBook ON. Start up SuperVisor. 
Select the COM port corresponding to the virtual USB COM port. Turn the 24V 
power supply ON. If the USB connection is kept OK, the green LED near the USB 
connector on the MCU board must be glowing permanently. Select Hardware 
Setting in the menu: 



 

 

 
 
 
 
 

5.1.4 Test report 
Record the values of the parameters listed in clause 5.1.1 in the test report. 

6. Testing and calibrating current and voltage 
6.1 Testing and calibrating current  

6.1.1 Technical requirements 
To set the calibrating current value of 3000mA and Offset of current. 

6.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. Cable to connect the IRS to the mains. 

6.1.3 Procedure 
Open the IRS box door. Connect USB cable to PC or NoteBook, connect the other end of the cable to 
MCU board. 
For convenience of further work with the IRS box closed, we recommend to unscrew the tap in the box 
and use the technological hole for laying USB cable and later T6 tool for Overload mode test (as 
shown in Fig). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 USB LED 

USB  
Connector 



 

 

 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near 
the USB connector on the MCU board must be glowing permanently.  
Then switch the IRS to the main power supply. 
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed.  
AC power ON, Oven OFF. Tune the Offset to get 
I Inst =  0 +- 10mA (I Inst = I Read – I Offset) and press 
Set Offset button. 
Turn the power supply and 24V unit OFF.  Disconnect the 
cables form the current sensor and set Tool T1 (calibrating 
resistor) in CN1 connector as shown in Fig  below.   
 
 
 
 

Turn the 24V power supply ON, turn the AC power supply 
ON. Current must set to 3000mA. Press Calibrate Current 
button.  
After testing, connect the current sensor back. 

 
? 
 
 
6.1.4 Test report 
If the current calibration is done OK, then the test Passed (P), if not - Not Passed (N). 
 

6.2 Testing and calibrating voltage 
6.2.1 Technical requirements 
To set the calibrating voltage value. 

6.2.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. USB cable. Cable to connect the IRS to the mains. 

6.2.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near 
the USB connector on the MCU board must be glowing permanently.  
Then switch the IRS to the mains. 
Use your Multimeter and measure mean square value of AC 
voltage at the IRS input under the general testing scheme (U4) 
clause10.2. Enter the measured value and press Calibrate 
Voltage button.  Vrms read and Vrms expected must get 
equal. 

6.2.4 Test report 
If voltage calibration is done OK, then the test Passed (P), if 
not - Not Passed (N). 
 

7. Testing the fans 
7.1 Testing the fans 

7.1.1 Technical requirements 
To test the fans operation. 



 

 

 
7.1.2 Instruments and tools 
24V power supply unit. Tool T5. 

7.1.3 Procedure 
Turn the 24V power supply ON. Hold your hand near the IRS rear wall (from the radiator side). There 
must be a feeling of the air flow from the fans blades  near the first and the second holes in the rear 
wall.  
7.1.4 Test report 
If you’ve got the feeling of the air movement – it means that the fans operate OK, then the test Passed 
(P), if not - Not Passed (N). 
 

8. Testing the channels operation 
8.1 Lamp ON in the selected channel at 100% power 

8.1.1 Technical requirements 
To test operation of the 1st to the 10th channel or the 1st to the 12th channel – depending o the IRS 
modification. 
8.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software.Tool 
T5. Tool T3. USB cable. Cable to connect the IRS to the mains. Auto transformer. Multimeter.  

8.1.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the 
COM port corresponding to the virtual USB COM port. Turn 
the 24V power supply ON. If the USB connection is kept OK, 
the green LED near the USB connector on the MCU board 
must be glowing permanently. Switch the load Tool T3 to the 
1st channel output under the general testing scheme clause 
10.2 (see the table in the diagram).   
We strictly recommend to disconnect the IRS from the mains 
when making any connection or changes in the circuit. If the 
mains is required to be ON for the job, keep the door always 
closed. 
Then switch the IRS to the mains. 
Use SuperVisor to set the nominal voltage or nominal power (depending on the IRS version) in the 1st 
channel and switch the Oven ON. The load lamps must be glowing permanently. Then sequentially set 
the nominal voltage or nominal power for all the rest channels. There, the load lamps must not glow. 
Switch the Oven OFF.  Disconnect the IRS from the mains and switch load Tool T3 to the next channel 
2. Repeat the procedure for the 2nd channel. Continue for all the rest channels. 

8.1.4 Test report 
If in each channel, for which the nominal voltage or nominal power is set, the load lamps are 
permanently ON, and for the channel, which is not selected, the lamps are OFF, then for each channel 
the test Passed (P), otherwise - Not Passed (N). 

Power regulation in the selected channel and stabilization 
at changing the input (power) voltage 
8.1.5 Technical requirements 
To check the power regulation and stabilization at changing the input voltage in the 1st to the 10th 
channel or in the 1st to the 12th channel depending on the IRS modification. 
8.1.6 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. Tool T3. USB cable. Cable to switch the IRS to the mains. Auto transformer. Multimeter.  

8.1.7 Procedure 



 

 

Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near 
the USB connector on the MCU board must be glowing permanently. Switch the load Tool T3 to the 1st 
channel output under the general testing scheme in clause 10.2 (see the table in the diagram).   
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed. 
Then switch the IRS to the mains. 
Use SuperVisor and set the half value of the nominal voltage or the half value of the nominal power 
(depending on the IRS version) in the 1st channel and switch the Oven ON. The load lamps must glow 
half heat. At the auto transformer output, using the Multimeter to control the voltage, set the voltage 
+10% of the nominal. The load lamps must glow with the same brightness.  At the auto transformer 
output, using the Multimeter to control the voltage, set the voltage -10% of the nominal. The load lamps 
must glow with the same brightness.  Switch the Oven OFF. Turn the IRS off the mains and switch the 
load Tool T3 to the next channel 2. Repeat the procedure for the 2nd channel. Repeat for all other 
channels. 

8.1.8 Test report 
If in each channel, for which half nominal voltage or half nominal power Is set, the load lamps glow half 
heat and their brightness does not change at changing the input supply voltage, then for each channel 
the test Passed (P), otherwise - Not Passed (N). 
 

8.2 DeadLamps identification 
8.2.1 Technical requirements 
To test the mode of the DeadLamps identification from the 1st to the 10th channel or from the 1st to 
the 12th channel depending on the IRS modification. 
8.2.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5.  USB cable. Cable to switch the IRS to the mains. Auto transformer. 

8.2.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near 
the USB connector on the MCU board must be glowing permanently. Switch the load Tool T3 to the 1st 
channel output under the general testing scheme clause 10.2 (see the table in the diagram).   
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed. 
Then switch the IRS to the mains. 
 Use SuperVisor to set the nominal voltage or nominal power 
(depending on the IRS version) in the 1st channel and switch the 
Oven ON. Then press the button on Tool T3, thus imitating a dead 
lamp. DeadLamp icon must appear in SuperVisor window. 
Switch the Oven OFF.  Disconnect the IRS from the mains and 
switch load Tool T3 to the next channel 2. Repeat the procedure for 
the 2nd channel. Continue for all the rest channels. 

8.2.4 Test report 
If the DeadLamp is detected for each channel, then for each channel 
the test Passed (P), otherwise – Not Passed (N). 
 
 
 
 
 
 
 
 
 
 
 



 

 

9. Testing SD card operation and Overload, Cutout, Sector 
Default modes 
9.1 Preparation and testing SD card operation (initialization, 
writing, reading) 

9.1.1 Technical requirements 
To test SD card initialization, writing and reading. 
9.1.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed 
SuperVisor software. Tool T5. Tool T3. USB cable. Cable to connect the IRS to 
the mains. Auto transformer. Multimeter. SD card. 

9.1.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port 
corresponding to the virtual USB COM port. Turn the 24V power supply ON. If 
the USB connection is kept OK, the green LED near the USB connector on the 
MCU board must be glowing permanently.  
Datalog uses Transcend, Kingston SD cards up to 2GB. SD cards of other 
make might be used, but they were not tested and their reliability is not 
guaranteed. Insert MicroSD into the adapter and then insert the adaptor into the PC or NoteBook card 
reader. Before use SD card must be prepared. To do so, choose in the tool bar Tools -> Log -> 
Prepare SD Card. For more details about SD Card operation, read AN Work with a DATALOG STD. 
Next, check the prepared card operation in the known-good MCU board Datalog. For this, insert the 
SD card into the card holder of the MCU board. You may insert and remove the card without turning off 
the 24V supply. But you can do so ONLY when the “SD Card 
communication LED” is flashing. After the card is inserted, “SD Card 
communication LED” must be glowing permanently. Then insert the 
tested and good SD card into the MCU board of the tested IRS. After 
the card is inserted, “SD Card communication LED” must be glowing 
permanently. It means, that MCU board Datalog initialize, write on and 
read the SD Card.  
Note: MCU board program is made so that after the card is inserted 
into the holder, the SD card is initialized first, and only then the data 
are tried to write or read.   

9.1.4 Test report 
If the SD Card is initialized, written on and read, then the test Passed 
(P), if not – Not Passed (N). 
 
 

9.2 Testing Overload mode and writing the event on the card 
9.2.1 Technical requirements 
To test Overload mode and write the event on the card. 

9.2.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. Tool T3. Tool T6.  USB cable. Cable to connect the IRS to the mains. Auto transformer. Multimeter. 
SD card. 

9.2.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Open the IRS box door. Connect Tool T6 and USB cable through the servicing hole. 
Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near the USB 
connector on the MCU board must be glowing permanently. Insert the prepared SD card into the card 
holder of the MCU board. 
 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed. For this and 
other tests, switch the breaker after the auto transformer to 45A – see the general testing scheme in 
clause 10.2. 
Then switch the IRS to the mains. 
Check that the IRS box door is closed. Press the button on T6. Overload protection must get activated. 
Overload message must appear in SuperVisor window. Switch off the IRS from the mains. Open the 
IRS box door – both breakers must be “open”. 
Remove the SD card from the MCU board holder and insert it into the card reader. In SuperVisor menu 
go to File -> Open. In the opened window select events file and press open button.   
To view the log file use Events window: 
 
 
 

 
 

9.2.4 Test report 
If both the breakers operate, Supervisor displays Overload, and the Overload event is written on the 
SD card, then the test Passed (P), if not – Not Passed (N). 



 

 

9.3 Testing the Cutout mode and  writing the event on the 
card 

9.3.1 Technical requirements 
To test Cutout mode and write the event on the card. 
9.3.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. Tool T3. USB cable. Cable to connect the IRS to the mains. Auto transformer. Multimeter. SD card. 

9.3.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Open the IRS box door. Connect Tool T6 and USB cable through the servicing hole. 
Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near the USB 
connector on the MCU board must be glowing permanently. Insert the prepared SD card into the card 
holder of the MCU board. 
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed. For this and 
other tests, switch the breaker after the auto transformer to 45A – see the general testing scheme in 
clause 10.2. 
Then switch the IRS to the mains. 
Check that the IRS box door is closed. Switch breakers 45A BR1 (after auto transformer) to “open”. 
Cutout protection must get activated. Cutout message must appear in SuperVisor window. Switch off 
the IRS from the mains. Remove the SD card from the MCU board holder and insert it into the card 
reader. In SuperVisor menu go to File -> Open. In the opened window select events file and press 
open button.   
To view the log file use Events window: 
 
 
 

9.3.4 Test report 



 

 

If Supervisor displays Cutout, and the Cutout event is written on the SD card, then the test Passed (P),  
if not - Not Passed (N). 
 

9.4 Testing the Sector defualt mode and  writing the event on 
the card 

9.4.1 Technical requirements 
To test Sector defualt mode and write the event on the card . 
9.4.2 Instruments and tools 
24V power supply unit. Personal computer (PC) or NoteBook with installed SuperVisor software. Tool 
T5. Tool T3. USB cable. Cable to connect the IRS to the mains. Auto transformer. Multimeter. SD card. 

9.4.3 Procedure 
Switch PC or NoteBook ON. Start up SuperVisor. Select the COM port corresponding to the virtual 
USB COM port. Open the IRS box door. Connect Tool T6 and USB cable through the servicing hole. 
Turn the 24V power supply ON. If the USB connection is kept OK, the green LED near the USB 
connector on the MCU board must be glowing permanently. Insert the prepared SD card into the card 
holder of the MCU board. 
We strictly recommend to disconnect the IRS from the mains when making any connection or changes 
in the circuit. If the mains is required to be ON for the job, keep the door always closed. For this and 
other tests, switch the breaker after the auto transformer to 45A – see the general testing scheme in 
clause 10.2. 
Then switch the IRS to the mains. 
Check that the IRS box door is closed. Set the autotransformer voltage to 20% more than nominal. 
Sector default protection must get activated. Sector default message must appear in SuperVisor 
window. Switch off the IRS from the mains. Remove the SD card from the MCU board holder and 
insert it into the card reader. In SuperVisor menu go to File -> Open. In the opened window select 
events file and press open button.   
To view the log file use Events window: 
 
 

 



 

 

9.4.4 Test report 
If Supervisor displays Sector default, and the Sector default event is written on the SD card, then the 
test Passed (P),  if not - Not Passed (N). 

 
10. Appendix 

10.1 Tools: 
Necessary materials and accessories: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Standard tools and devices: 
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Tool ?  Name of the tool or device 
1 Screwdrivers 
2 Measuring probes for Multimeter 
3 T3 Test load 460V 100W  
4 T6 OverLoad regime testing tool 
5 T1 Current calibration tool  
6 T4 Connecting cable, PLC OMRON to MCU board  IRS 
7 T5 IRS power feeding cable  
8 U5 Power supply unit 24V >3A 
9 U4 Multimeter with the possibility of measuring the rms ac voltage 

10 T2 USB cable 
11 U6 PLC  OMRON 
12 Connecting cable, PLC OMRON to PC or Notebook 
13 U1 Autotransformer 
14 U8 FLUKE 196 ScopMeter, optional  
15 Cable to connect IRS to power supply (16A) 

  
10.2 General testing scheme 
General testing scheme: 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
BOM for general testing scheme: 

 
Pos.  Description  No. in Farnell 

catalog 
 U1 AutoTransformer STACO ENERGY PRODUCTS - 2520-2 - Variable 

Transformer  
 

1381710 

CN9 Power Connector: 
HARTING - 0914 002 2751 - INSERT, FEMALE, AXIAL, SCREW, 100A, 
HARTING - 0930 006 1750 - COUPLER, HAN6B  
HARTING - 0914 024 0313 - FRAME HINGED HOUSING, 6 MODULE 

 
3453881 
3454460 
3329835 

 
R Resistor 10K +/-0.1% 0.25W  
R Resistor 100 Ohm +/-5% 0.25W  
? Capacitor 100uF 63V  

BR1 Breaker 40A  
LAMP1,2 LAMP 230V 100W  

 


